EndNote X7
Quick Start Handout
for Windows
Before Getting Started
Site License
EndNote is software for managing and searching bibliographic references. It stores, organizes, and formats citations for bibliographic
references for journal articles, books, web pages, court cases, technical papers, and other forms of scholarly communication.
1. This software may be used by registered students, faculty, and staff at North Carolina Agricultural & Technical State University.
2. An eligible member’s use of the software at a principal residence is limited to use related to coursework, research, or other work
directly related to the user’s relationship with the university.
3. This license is only valid while the owner of the computer is associated with North Carolina Agricultural and Technical State
University, i.e. when a person leaves the University, whether to take employment elsewhere or because they have graduated,
they must to remove EndNote from any privately owned computers or purchase a private copy.
4. Persons leaving the University may purchase a retail version of EndNote to ensure they retain rights to the software.

Things to Consider
1. It is advised to remove previous versions of EndNote before installing EndNote X7.
2. EndNote can generate a bibliography by citing and formatting references, a feature known as Cite While You Write™, in:
Apple Pages ‘09,
Wolfram Mathematica 8+
Microsoft® Word 2003, 2007, 2010, 2013
Other word processors using RTF files, such as WordPerfect,
OpenOffice.org Writer, StarOffice, & WordPad
OpenOffice.org Writer 3 for Windows.
3.
4.

For the first time, EndNote can insert in-text citations into PowerPoint (but does NOT build the bibliography at the end).
Instructional videos are available at www.youtube.com/endnotetraining and http://endnote.com/training.

Installing EndNote
1.
2.
3.
4.
5.

6.
7.
8.

Uninstall any previous version of EndNote. Your EndNote libraries will not be affected.
Open the EndNote X7 Windows folder on your flash drive or CD (as distributed by the Library Staff).
Click on ENX7Inst.msi
(Windows Installer Package)
Follow the prompts to install. (Microsoft Word should NOT be open [nor any Microsoft product] – if it is, you will be prompted
to close it.)
At the Select Installation type prompt, we recommend selecting Custom. After selecting the destination of the EndNote folder,
select at the Select Features prompt, “Entire Feature will be installed on local hard drive” from the drop down menu beside
“EndNote X7 for Windows”
Check “Install Direct Export Helper.”
Click “Next” and “Continue” to follow prompts to install.
EndNote X7 will prompt you to install any recent updates as the updates are released..

Definitions
Library: Collection of references
Reference: An item in your EndNote Library that consists of bibliographic information, e.g. title, author, publisher
Export, Download, Save, Send To: terms used to denote the process of beginning to directly export a citation to EndNote
Group: User defined method to organize references

Getting Started
Create New Reference
2 ways to create a new reference:

1. Manually create
1.
2.
3.
4.

From the References Menu, Select “New Reference”. Or, click
Near the top menu bar, select which Reference Type
Type (or cut & paste) into each field
Close the box. And Save, when prompted.

5.

Citation will directly import into EndNote & appear in the library.
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2. Import articles directly from a database (instructions for Firefox, Internet Explorer, and Chrome)
Examples:
From EBSCOhost databases (examples: Academic Search Complete, CINAHL, EconLit, & PsycArticles)
(For Single Reference)
1. Click on the title of the citation.
2. Click on the Export link on the right hand of screen.
3. Select “Direct Export in RIS Format (e.g. CITAVI, EasyBib, EndNote, ProCite, Reference Manager, Zotero)”.
4. Click on the orange Save button.
5. Depending on your browser:
Firefox: at prompt to open a file “delivery.ris” with “Research Soft Direct Export Helper”, click “OK”
Internet Explorer: at prompt to open or save “delivery.ris from ebscohost.com”, click “Open”
Chrome: a “delivery.RIS” file appears in the lower left corner, click it to “Open”
6. Citation will directly import into EndNote, and appear in the specified library.
From ProQuest databases (examples: ABI/Inform Complete, ProQuest Central, & Dissertations & Theses Full Text)
(For Single Reference)
1. Click on the title of the citation.
2. Hover over the Export/Save link in the blue bar and click on:
3. At the Export/Save pop-up, click the orange Continue button:
4. Depending on your browser:
Firefox: at prompt to open “ProQuestDocs[date].RIS” with “ResearchSoft Direct Export Helper”, click “OK”
Internet Explorer: at prompt to open or save “ProQuestDocs[date].RIS from proquest.com”, click “Open”
Chrome: a “ProQuestDocuments….RIS” file appears in the lower left corner, click it to “Open”
5. Citation will directly import into EndNote, and appear in the specified library.
From Science Direct
1. From the result list, check on each citation desired.
2. Click “Export” button above first citation.
3. Under “Export file”, select “RIS (for EndNote, Reference Manager, ProCite”.
4. Under “Content”, select “Citations and Abstracts”
5. Click on “Export”.
6. Depending on your browser:
Firefox: at prompt to open “science….ris” with “ResearchSoft Direct Export Helper”, click “OK”
Internet Explorer: at prompt to open or save “science….ris from sciencedirect.com”, click “Open”
Chrome: a “science….ris” file appears in the lower left corner, click it to “Open”
7. Citation will directly import into EndNote, and appear in the specified library.
From PubMed
1. Check on the desired citation from the results list.
2. Click on “Send to:” on the right hand side.
3. Select Citation Manager as the destination.
4. Click on “Create File”.
8. Depending on your browser:
Firefox: at prompt to open “citations.nbib” with “ResearchSoft Direct Export Helper”, click “OK”
Internet Explorer: at prompt to open or save “citations.nbib”, click “Open”
Chrome: a “citations.nbib” file appears in the lower left corner, click it to “Open”
5. Citation will directly import into EndNote & appear in the specified library.
From AggieGOLD [NOTE: recommended only for books via catalog or WorldCat. Export from Databases for articles.]
1. Click on the title of the book.
2. Click on this image on the right hand side:
3. Select “Cite record.
4. Choose “Cite with EndNote”.
5. Depending on your browser:
Firefox: at prompt to open “citation.ris” with “ResearchSoft Direct Export Helper”, click “OK”
Internet Explorer: at prompt to open or save “citations.ris”, click “Open”
Chrome: a “citation.ris” file appears in the lower left corner, click it to “Open”
6. Citation will directly import into EndNote & appear in the specified library.
7. Minor editing will be necessary to the Title ( :), Place Published (;), Edition (ed.) and possibly other fields.
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Adding Full Text to References
There are 2 recommended ways to attach full text PDFs to a reference: Find Full Text and Attach a PDF.
Find Full Text Option:

1.
2.
3.
4.
5.

This feature works best with References that have a URL or DOI in appropriate reference field.
Note 1: most books and theses do not have DOIs (Digital Object Identifiers) as these are assigned only
by authorized publishers.
Note 2: If you exported the reference from a publisher’s database or Web of Science and not an
aggregator (EBSCOhost or ProQuest), there is a greater chance that this option will succeed.
From All References, Unfiled References, Imported References, or even any Group: Highlight all of the
references where full text .PDFs are desired.
Right Click over these “References,” select “Find Full Text,” then “Find Full Text,” again.
Alternatively, click on the “Find Full Text” icon in the Tool bar.
On the left, the “Find Full Text” area will begin to show progress of PDFs found, URLs found, and not found.
A paper clip will appear beside each reference if and when the .PDF has been found and attached to the record.

Attach a single PDF:

This feature should be used when the “Find Full Text” option fails to find and attach the .PDFs.

1.
2.
3.
4.
5.
6.

One should save the .PDF of an article, thesis, or report when it is discovered.
Save the item to a place where you have local control, i.e. a folder, flash drive, desktop, etc.
When saving, one suggested “Best Practice” is to name the PDF with Author_Year_Title, i.e. DuBois 1903 Souls
In EndNote, Highlight the reference.
Go to right column, then click on the paper clip icon to “Attach File”.
Select a File to link to the reference. (The file that was saved earlier.)
7. The PDF should be visible in the right-hand column.
8. If you open the .PDF, you will be able to read and annotate the item.
9. Close the .PDF. When prompted about changes, select “Yes”. A paper clip will appear beside the reference.
Import multiple PDFs at once (if you have several sources stored in one folder). This method is not recommended.
1.
2.
3.
4.
5.

Go to the File menu. Select “Import”, then “Folder”, then select “Choose” and browse for the folder.
Check “Create a Group Set”. The import option should be PDF.
Select Import All, Discard Duplicates, or Import into Duplicates Library.
All of the PDFs will appear in the EndNote Library in the Group Set created.
A completed record will be created for those PDFs with DOI or URL fields and other metadata. An incomplete
record will be created for those without DOI or URL info.

To Organize Library
To create a Group Set
1.
2.
3.
4.

Use Group Sets to organize the “big picture” of your research, i.e. Master’s Thesis or Dissertation
or Grant Proposal or Journal Article or Conference Paper
Right Click on My Groups at the left side of screen.
Select “Create Group Set”.
A box will appear under the My Group section.
Type in the name desired for this “big picture” item and press enter.

To create a Group
1.
2.
3.
4.

Use Group to organize within the “big picture” item, i.e. Introduction or Literature Review or
Materials and Methods or Participants or Results or Discussion
Right Click on My Groups or your recently created Group Set at the left side of screen.
Select “Create Group”.
A box will appear under the My Group or your new Group Set section.
Type in the name that you would like for a group of your data and press enter.

To place references into a group
1. Select a reference from the main library.
2. Right Click on the Reference and choose Add References To:
3. Select the Group desired.
To view only references in a particular group
1. Select the group name on the left side of screen.
2. Only references assigned to that group will appear.
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Cite While You Write
Cite While You Write® is a feature that allows direct access to your EndNote library while writing your document, enabling
citing and bibliography maintenance simultaneously.
EndNote installs Cite While You Write commands in several word processing programs.
 Word 2003 displays an EndNote submenu of commands on Word’s Tools menu.
 Word 2007, 2010, and 2013 displays Cite While You Write commands on an EndNote tab (see image above).
 Apple Pages ’09 displays an EndNote submenu of commands on Insert menu.
1.
2.
3.
4.
5.
6.
7.

Inside Word, place cursor where a citation should be placed.
Go to the EndNoteX7 tab, click on the “Insert Citation” icon. If prompted, select “Insert citation”.
An “EndNote X7 Find & Insert My References” prompt box will appear.
Type in a keyword or author name of the citation desired and click “Find.”
Click on desired reference and then click “Insert” (or double-click the reference).
An in-text citation will appear in the document. A bibliography entry will also be inserted.
The bibliography will appear near the end of the document. The bibliography will remain at the bottom of the
document as you continue to type.

Cite While You Write is interactive: you can change the output style quickly and easily; edit citations in EndNote and update
the edits quickly in Word; and change in-text citations to include page numbers.
Creating a Quick Bibliography (A list of references only)
EndNote can create a quick bibliography of all or selected references in a Library or Group.
1. At the EndNote library, highlight the selected references.
2. Go to File, then Export.
3. Select the destination of the file created. Save as “.rtf”.
4. Select the “Output Style”. (e.g. APA 6th, MLA, IEEE, etc.). Click “Save”.
5. Open the document from the destination selected in the Word Processing program you use..
(The document may need minor revisions, including formatting, name, title, etc.)
Creating a Quick Bibliography is NOT interactive. If you chose the wrong file type (.txt instead of .rtf) or chose the wrong
output style, you will need to start over again at Step 1.
This is a great tool if you need to provide an instructor, a professor, or your thesis advisor with a quick list of the resources
you have already identified. The resulting file can be modified by adding your name, class, date, etc. Then the file can be
uploaded to BlackBoard, sent as an email attachment, or copy and pasted into an email message. Some instructors ask you
to create annotated bibliographies. This Quick Bibliography can be modified easily for that assignment.

Notable Features of EndNote X7
Highlight and Add Sticky Notes to a Pdf
Text within a pdf attachment may be highlighted and noted using the highlight and sticky note options with the PDF Toolbar.
This can be done by 1) highlighting the text, 2) selecting the Highlight Text button, and 3) selecting the sticky note option.

Share a Citation and Pdf with colleagues from within EndNote (only for Mapi compliant email programs like
Outlook) A citation and pdf may be emailed to a colleague by clicking on the email button in the PDF Toolbar.
Sync with EndNote Online
EndNote Web and EndNote desktop libraries may be synced for library consistency. Before syncing, be sure to check for
updates by clicking “EndNote Program Updates” under the “Help” Menu. To create a back-up file 1) select File>Compressed
Library> All References & W/File Attachments, 2) Select a Location for the file, and 3) Click OK. To Sync, click on the Sync
Button. You can automatically sync your desktop, online, and iPad libraries so that all the references, attachments, and
annotations in one can be accessed from the other. Although only custom groups will appear online or on the iPad, all
groups and group sets will appear on all synced desktop computers.

Introducing: Library sharing for research collaboration
Through the sync services, EndNote now permits sharing libraries between 15 EndNote X7 users (14 plus the creator of the
library). You can start a library from scratch or share an existing library. All users must register fully and provide the email
used in EndNote to the person sharing the library. After a library has been shared, to access the library, login and Open
Shared Library.
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